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ABSTRACT 
 
The Washington DC Area geologic map database (DCDB) offers geologic map information to 
many types of professionals and to private citizens.  Digital, geographically referenced, geologic 
data is more versatile than traditional hard copy maps, and facilitates the examination of 
relationships between numerous aspects of the geology and other types of data such as: land-
use data, vegetation characteristics, surface water flow and chemistry, and various types of 
remotely sensed images.  The DCDB was created by combining Arc/Info coverages, designing a 
Microsoft (MS) Access database, and populating this database.  Proposed improvements to the 
DCDB include the addition of geochemical, structural, and hydrologic data. 
 
 

INTRODUCTION 
 
The Washington DC Area geologic map database (DCDB) is a database of geographically 
referenced geologic data for the Washington DC area.  The goal of this database is to make 
geologic map information of the Washington DC area more usable for geologists, engineers, 
environmental professionals, park professionals, and others who have uses for it. 
 
The data in the DCDB is based on geologic mapping done at scales ranging from 1:24,000 to 
1:100,000.  This primary data was then re-compiled at 1:100,000 in three 30 X 60 minute 
quadrangles: Frederick, Washington West, and Fredericksburg.  This data collection and map 
compilation work was conducted throughout the 1990s.  The source materials for the database 
are digital files involved in the publication of the Frederick quadrangle (Southworth et al., in 
press), the Washington West quadrangle (Lyttle et al., in press), and the Fredericksburg 
quadrangle (Mixon et al., 2000). 
 
The DCDB is a living and breathing database in the sense that it will change with time as new 
types of data are added and the geographic extent of the database is extended.  This document 
discusses the parts of the DCDB, how to use the DCDB, some of the methods used in its creation, 
and its future directions.   
 
 

DCDB CONSTITUENTS 
 
The file “dcdb_eesp.mdb” is a MS Access 2000 database.  It contains a collection of tables, 
queries, and forms that facilitate entry and storage of attribute data for the U.S. Geological Survey 
geologic maps of the Frederick, Washington West, and Fredericksburg 1:100,000 scale 30 x 60 
minute quadrangles. The data in this database can be accessed by running “MS Access” or 
through ArcView or Arc/Info via Open Database Connectivity (ODBC) drivers.  Geographic 
Information System (GIS) data is linked to the MS Access database by the fields MAP_UNIT, 
Mapunit, or MapUnit depending on the table.  The file “dcdb_dm.mdb” is a version of the MS 



Access database that is compliant with version 4.3 of the North American Data Model Standard 
for geologic map data (NADM).  Johnson et al. (1998) describes this data model in detail. 
 
Database Structure 
 
dcdb_eesp.mdb 
 
Tables 
[MAP_UNIT] – name and description of the Map Units 
[FORMATION] – reference table of formations, groups, and members for each Map Unit 
[LITHOLOGY] – primary, secondary, and tertiary lithologies of the Map Units 
[CLASTS] – lithologies of clasts and cement composition 
[MINERALS] – minerals ranked as primary, secondary, and other 
[METAMORPH] – prograde minerals, retrograde minerals, and metamorphic ages 
[PLANES] – inventory of the planar features of Map Units (i.e., bedding, schistosity, cleavage, 
etc.) 
[CHARACTER] – numerous unit characteristics 
[GEOCHRON] – isotopic ages and methods 
[SOURCE] – outside references for data within the database 
[provinces] – reference table for Appalachian physiographic provinces.  Like the other reference 
tables in this database, it stores the names associated with the numbers that are stored in the 
<Province> field of the [CHARACTER] table. 
[lin_type] – reference table for linear feature types (i.e., T = thrust fault, SS = strike-slip fault, etc.) 
[min_pt] – mineral abundances at specific point locations 
[lith_pt] – lithologic characteristics at specific point locations 
[gchron_pt] – isotopic ages at specific point locations 
[chemistry] – geochemical data for specific point locations 
[sink] – sinkhole size and trend information (currently, this information is not stored) 
[fossil] – Fossils at specific point locations 
[bed_entry] interim table during the data entry process 
[rock_class_chg] – reference table for converting the Southern California Mapping Project 
rock_class codes to those of the Standard data model 
[faults] – fault type and length (currently, this information is stored in the Arc/Info .aat file 
“fault.aat” and the .dbf file that is associated with the ArcView shapefile “fault.dbf”).  A reference 
table for the <type> field in the .aat and .dbf is stored in this database as table [lin_type] 
[structure] – structure type and strike and dip measurements (currently, this information is stored 
in the Arc/Info .pat file and the .dbf file that is associated with the ArcView shapefile) 
 
Queries 
---data entry--- 
[Append_Bedrock] – appends records from table [bed_entry] to table [CHARACTER] for bedrock 
units 
[Append_Clasts] – appends records from table [bed_entry] to table [FORMATION] 



[Append_Formation] – appends records from table [bed_entry] to table [CHARACTER] for bedrock 
units 
[Append_Lithology] – appends records from query [lithchange2] to table [LITHOLOGY] 
[AppendMapUnit] – appends records from query [lithchange2] to table [LITHOLOGY] 
[Append_Metamorph] – appends records from table [bed_entry] to table [METAMORPH] 
[Append_Minerals] – appends records from query [minchange] to table [MINERALS]  
[Append_Planes] – appends records from query [folchange] to table [PLANES] 
[Append_Surficial] – appends records from table [bed_entry] to table [CHARACTER] for surficial 
units 
[clastchange] – takes fields <ClastPrim> and <ClastSec> from the [bed_entry] table and puts their 
data into fields <CLAST_LITH> and <CLAST_RANK>  
[folchange] – takes fields <FoliatDom>, <FoliatSec>, and <FoliatTert> from the [bed_entry] table 
and puts their data into fields <FOLIATION> and <FOL_RANK> 
[lithchange2] – takes fields <LithPrim>, <LithSec>, and <LithTert> from the [bed_entry] table and 
puts their data into fields <LITHOLOGY> and <LITH_RANK> 
[minchange] – takes mineral information from the [bed_entry] table and puts it into fields 
<MINERAL>, <MIN_RANK>, and <MIN_TYPE> 
[name1] – updates fields <Name> and <Name_Rank> of the [bed_entry] table for map units that 
are members 
[name2] – updates fields <Name> and <Name_Rank> of the [bed_entry] table for map units that 
are formations 
---data viewing--- 
[output5] – presents name, lithology, mineralogy, and physiographic province information about 
the map units (a very good query for use with ArcView) 
[clast_comb] – presents clast information about the map units (a good query for use with 
ArcView) 
[lith_prim] – selects primary lithologies for use by query [output5] 
[lith_sec] – selects secondary lithologies for use by query [output5] 
[lith_tert] – selects tertiary lithologies for use by query [output5] 
[members] – selects map units that are members of formations.  It is a supporting query for the 
query [output5] 
[min_prim] – selects primary minerals for use by query [output5] 
[min_sec] – selects secondary minerals for use by query [output5] 
[min_oth] – selects other minerals for use by query [output5] 
 
Relationships 
A diagram that illustrates the joins between tables in dcdb_eesp.mdb is available by selecting 
“Relationships” from the “Tools” menu in MS Access.  In this database, the field <MAP_UNIT> is 
the one that facilitates many of the joins that exist between the tables. 
 



dcdb_dm.mdb 
 
Tables 
[COA] – Map Unit names and descriptions – a data linkage hub in NADM 4.3 
[Lithform] – lithological classification reference table for the <lith_form> field in table 
[RockComposition].  It currently does not contain the right type of values to work with the data in 
the <lith_form> field. 
[Lithology] – lithological terms defined 
[Organization] – the organization(s) that are responsible for the data 
[Projection] – details about the geographic projection(s) used for the geospatial data 
[RockComposition] – contains most of the lithologic data.  Data from the field <Origin> of table 
[CHARACTER] was placed into the field <lith_form> of the [RockComposition] table. 
[RockUnit] – rock unit rank (i.e., formation, member, group, supergroup) and thickness 
[RockUnitRank] – reference for rock rank information 
[StratigraphicAge] – stratigraphic ages of the Map Units 
[StratigraphicRank] – ranks the geologic time names 
[StratigraphicTime] – look up table for geologic time names 
[Structure] – classifies structural data into types 
[StructureType] – look up table for types of structural data used in the table [Structure] 
---same as dcdb_eesp.mdb--- 
[MAP_UNIT] – name and description of the Map Units  
[CLASTS] – lithologies of clasts and cement composition 
[MINERALS] – minerals ranked as primary, secondary, and other 
[METAMORPH] – prograde minerals, retrograde minerals, and metamorphic ages 
[PLANES] – inventory of the planar features of Map Units (i.e., bedding, schistosity, cleavage, 
etc.) 
[CHARACTER] – numerous Map Unit characteristics 
[GEOCHRON] – isotopic ages and methods 
[SOURCE] – references for data within the database 
[lin_type] – reference table for linear feature types (i.e., T = thrust fault, SS = strike-slip fault, etc.) 
[provinces] – look up table for Appalachian physiographic provinces 
 
Queries 
Five queries used to put the dcdb_eesp.mdb into dcdb_dm.mdb are stored in dcdb_dm.mdb: 
[Make_COA], [Make_COADescription], [Make_RockComposition], [Make_Rock_Unit], 
[Make_StratigraphicAge] 
 
Relationships 
A diagram that illustrates the joins between the tables in dcdb_dm.mdb is available by selecting 
“Relationships” from the “Tools” menu in MS Access.  The <coa_id> field is the one that allows 
the relationships among the data that was put into the NADM format.  In order to connect to other 
data and to ArcView shapefiles the field MAP_UNIT must be used or the <coa_id> fields in the 
ArcView shapefiles must be populated. 



 
 

GIS Layers 
 
The GIS data layers that were compiled for this project include: 
 
bedrock – bedrock and coastal plain map units 
surficial – surficial materials 
faults – faults, fold axes, and thermal aureoles  
structure – point structural measurements  
sink – sinkholes 
 
These layers are included on the CD as Arc/Info coverages and export files, ArcView shapefiles, 
and SDTS files.  The attribute data for these GIS Layers is stored in the MS Access database 
mentioned in this document, except in the cases of faults and structure whose attribute data is 
stored in the Arc/Info attribute tables or .dbf files associated with ArcView shapefiles. 
 
 

USING THE DATABASE WITH THE GIS LAYERS 
 
Instructions for using the MS Access database (dcdb_eesp.mdb) in concert with the ArcView 
shapefiles (.shp extensions): 
 
For ArcView 3.1 or 3.2a 

1. Open ArcView 
2. Continue with the default new project or use the project provided in this open file report 

by selecting "Open Project" from the "File" menu and navigating to 
"c:\ofr01227\of01227.apr".  If you elected to stay with the new project, then you will need to 
start a new "View" by clicking on the "Views" tab of the "Project" window, and then clicking 
on the "New" button.  If using a new project you will have to select "Add Theme" from the 
"View" menu and select the shapefiles that you desire.  If you elected to use the project 
provided ("of01227.apr"), four views have already been created.  These views are named 
Bedrock, Surficial, Fault, and Structure. 

3. Select the "Extensions" option from the "File" menu and make sure that the "Database 
Access" option is checked. 

4. Bring the project window to the front.  To do this, select the project (e.g.,"of01227.apr" or 
"untitled") from the "Window" menu to make sure that the project window is active. 

5. Select "SQL connect" from the "Project" menu.  A dialog box will appear. 
6. Select "MS Access Database" from the top pick list, and click the "Connect" button. 
7. Then choose dcdb_eesp.mdb or dcdb_dm.mdb from the directory/file dialog box. 
8. Double click on the table/query that you want.  For example, select query [output5].  By 

double-clicking, its name will be placed in the "From" text box. 



9. Double click on the fields that you want. For example, select "All Columns" and an "*" is 
placed into the "Select" box.  Please see the ArcView Help Menu if more discussion about 
the "SQL Connect" feature is needed. 

10. Once "Query" is clicked another table will appear in your ArcView project - by default it 
will be called [Table1].  Move the SQL dialogue box to the back or close it. 

11. Select a field in this table and a field in an ArcView attribute table (i.e., the table that 
corresponds to the active theme in a "view") that you wish to join it to.  For example, select 
the field <MapUnit> in "Table1" (the ArcView name for "output5") by clicking on the top of 
the data column, then select the field <Mapunit> in the attribute table of the "bedrock.shp" 
theme. 

12. Make sure that the ArcView attribute table is active (click on its window) and then click 
on the join button or select join from the "table" menu.  Useful joins include: 
        MS Access       ArcView 

                      output5              bedrock.shp or surficial.shp 
                     CHARACTER      bedrock.shp 
                     MAP_UNIT        bedrock.shp or surficial.shp 
                     clast_comb       bedrock.shp or surficial.shp 
                     GEOCHRON       bedrock.shp 
                     FORMATION     bedrock.shp or surficial.shp 

13. Now the symbolization of the bedrock theme can be altered.  For example, with "View1" 
active, double-click on the "bedrock.shp" theme in the legend bar to the left of the map.  
From the dialogue box that appears, select "Unique Value" from the "Legend Type" box and 
choose the field <ROCK_GRP> from the "Values Field" box.  Then select "Apply", and a 
newly classified map is drawn. 

 
DATA ENTRY 

 
To enter geologic information into the MS Access database dcdb_eesp.mdb, open the form 
“Intro” and you will be presented with forms for inputting your data.  The forms are presented in 
the following order: 

1. [Intro] 
2. [BEDROCK_GENERAL_A] 
3. [BEDROCK_GENERAL_B] 
4. [STRUCTURE_POINTS] 
5. [LITHOLOGY_POINTS] 
6. [MINERAL_POINTS] 
7. [SINK_HOLES] 
8. [FOSSIL_POINTS] 
9. [CHEMISTRY_POINTS] 
10. [GEOCHRON_POINTS] 

 



After the forms are filled in, the data must be placed into the appropriate tables for storage.  To 
accomplish this, queries can be run by opening them from the database queries window.  Using 
this approach, they must be run in this order: 
 

1. name1 
2. name2 
3. Append_Character 
4. Append_Lithology 
5. Append_Minerals 
6. Append_Clasts 
7. Append_Metamorph 
8. Append_Planes 
9. AppendMapUnit 
10. Append_Formation 

 
 
The reference tables [provinces], [lin_type], and [rock_class_chg] must be populated separately 
and forms have not been created for them.  Pick lists should be negotiated for the lithology and 
rock_class fields.  This set of forms does not accommodate data entry for the attribute data 
associated with faults and folds.  These data need to be added to the fault.dbf and fault.aat for the 
ArcView shapefile and Arc/Info coverage, respectively.  To convert the data to an NADM 
compatible format, queries stored in dcdb_dm.mdb can be used. 
 
 

METHODS 
 
Creating the DCDB involved piecing together digital datasets of three 30 X 60 minute quadrangles 
(Frederick, Washington West, Fredericksburg).  These data were in the form of multiple Arc/Info 
coverages.   
 
Several tasks were performed to combine these data into one bedrock coverage, one surficial 
coverage, one fault and fold axes coverage, one structural measurements coverage, and one 
sinkhole coverage.  The tasks were: Identification and separation of surficial units, Joining of 
coverages, Edgematching and making Map Unit codes uniform, Database structure design, and 
Population of the Database. 
 
The surficial geologic units were identified and then separated from the Washington West and 
Fredericksburg coverages and placed into separate coverages.  The result was separate bedrock 
and surficial coverages. 
 
The surficial, bedrock, fault and fold axes, and structure point coverages of each individual 30 X 
60 minute quadrangle were combined with their counterpart in the other quadrangles.  For 
example, the “faults” GIS coverage of the Fredericksburg 30 X 60 minute quadrangle was 



combined with the “faults” GIS coverage of the Washington West and Frederick 30 X 60 minute 
quadrangles. 
 
Edgematching along the quadrangle boundaries was necessary to remove “boundary faults”.  
Approximately one half of the contacts that crossed the Frederick/Washington West boundary 
were modified.  Fewer modifications were required for the Washington West/Fredericksburg 
boundary.  Map Unit codes were altered so that the codes were unique identifiers of the Map 
Units in the combined dataset.  For example, “Cl” and “OCl” were both codes for the Lunga 
Reservoir Formation, and OCl had to be chosen as the correct code. 
 
The database for storing information about the map features was designed based on fields and 
relationships suggested by field geologists of the Eastern Earth Surface Processes Team of the 
U.S. Geological Survey.  One large spreadsheet style table was split up to allow normalization of 
lithologic, mineralogic, clast, and planar feature information.  “dcdb_eesp.mdb” is the resulting 
digital database file in MS Access format. 
 
During the database design process, a method for entering data into its format was designed 
using MS Access “forms” and “queries” (see previous section “Data Entry” for more details).  In 
addition, a method for converting this design to the North American Data Model Standard was 
created. “dcdb_dm.mdb” is an example of this database. 
 
 

CONCLUSION 
 
There are many potential uses for the data in the DCDB.  Some of these uses include: correlation 
of vegetation types with rock and surficial material types, comparison of isotopic ages with 
various tectonic models, and examination of the relationships between structural features and 
sinkhole development.  As the DCDB expands to include geochemical, porosity, and fracture 
density data our ability to examine the effects of the geology on ecosystems will be greatly 
enhanced.  The geochemical data will also greatly enhance our ability evaluate tectonic models, 
and the fracture density and porosity estimates will facilitate greater understanding of sinkhole 
development. 
 
In addition to being a very useful regional database, The DCDB is a prototype for a national 
database.  It will be used to evaluate the effectiveness of the North American Data Model 
Standard, and will be a building block for a National Geologic Map Database. 
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